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1. Introduction 
The OpenSuite is the latest version of the PG2 Suite, suited to edit the new file formats of Open 
General. With it you can also create or modify scenarios, campaigns, efiles and maps. 
The OpenSuite can read files created for PG2, but its main purpose is to work with Open General’s 
files, so it can only save files using the new formats. If you want to work with PG2 files or old 
formtas you should use the “normal” Suite from Luis’ site. 

2. Open General folder structure 

 

To make it easier to use several Efiles without needing 
multiple installations of the program, Open General uses a 
system of folders containing the Efiles. The main program 
folder includes subfolders with all needed files; this structure 
can be duplicated in the Efiles folders, with specific files 
used by them. You can see an example in the image; of 
course you could have more folders (for more Efiles). 
The subfolders of the main game folder are: 

 MAP: map images and .XMAP files (terrain 
definitions). 

 OPENGUI: default user interface images. 
 OPENDAT: default flags, start screen, medals, 

leader’s images… 
 SOUNDS: music and game sounds. 
 SFX: unit’s sounds. 
 SMACK: game videos. 

The OpenIcons.dat file contains the unit icons, and 
OpenIcons.txt the description for them. 
In addition to the above subfolders, there are several folders 
that begin with "EFILE_" followed by a name: these are the 
folders of the different Efiles. 
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Inside each one, there must be at least one SCENARIO folder 
for scenarios and campaigns, and one SAVE folder for the 
savegames of the Efile; EQUIP.xeqp, EQUIP.txt and 
NATIONS.txt are required too. In addition they can also 
duplicate the structure of the main folder, and then the files 
that are in them are used first. 

 EQUIP.xeqp and EQUIP.txt: the units’ stats and their 
names, respectively. 

 NATIONS.txt: the efile countries. 
 NAMES.txt: leader’s names. 
 TERRAIN.txt: terrain name and data, including the 

movement costs. 
 STRINGS_EFILE.txt: all the text used by the efile. 
 COLORS.txt: interface colors. 
 EYEAR.txt: base year; default is 1900, although 

preferred method is to set in the equipment file. 
The scenarios and campaigns for each efile must be in the 
SCENARIO folder of the efile. Each scenario consists of the 
following file types: 

 .XSCN, the scenario properly. 
 .PLY or .TXT for the scenario intro. 
 .TMSG turn messages. 

The campaigns consist of a number of scenarios, and one .XCAM file for the campaign info; there 
can be also .PROTO files for customized lists of prototypes and .XSCH files for choice scenarios. 
Open General can also use all material made for Panzer General 2: campaigns, efiles, scenarios… 

3. Suite installation 
To install the Suite, go to Luis’ page (http://luis-guzman.com/) and download it; then extract the 
files in Open General main folder. 

The first time you run the Suite, 
it will show a dialog asking to 
configure it. The main info is 
the Game folder, which you 
can change by pressing the 
button with three points in it. It 
is also recommended to check 
Avoid editing E-File… to 
avoid mistakes. If all is right 
you can press OK. You can 
return always to this window 
with Tools  Settings… 
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4. Overview 

4.1. Toolbar buttons 
You have a toolbar under the menu bar, with the main functions of the Suite. If you can’t see it, go 
to View  Toolbar. 
In the toolbar you have many buttons, which allows you to do many things. They are: 

 

Change Efile folder 

 

Load Scenario file 

 

Load Campaign file 

 

Load Save game file 

 

Load equipment file 

 

Load map 

 

Load Nations (or GUI97) 

 

Load icons file, either Openicons.dat or Panzer2.dat 

 

Save 

 

Save as 

 

Settings, Folders and Files 

 

View Error Log 

 

Edit text file 

 

Icons Report 

 

Report 

 

Global editing 

 

Stop Sounding! 

 

Check Files View 

 

Campaign View 

 

Scenario Summary View 
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Unit Settings View 

 

Map Settings View 

 

Equipment File Maintenance View 

 

Map Editor View 

 

About 

4.2. Suite Views 
The Suite has seven main windows; each one allows you to work with some component of the 
game. You can change between them with the View menu or with the toolbar buttons. 

4.2.1. Check files view 
Here you can check the campaigns and scenarios from an efile for missing files. You can select if 
the files are in PG2 format or OG format; then it shows a list of campaigns and scenarios in the left, 
where you can look at them, and a list of maps found in the right. In the center you can see a 
preview of the map used by the scenario or the maps selected. 
If you double-click on any item from left (campaign/scenario) or right panels, you can load the 
file(campaign, scenario or map file). Can also see all maps needed filtered at MapFinder or 
download manually by accessing Steve map site or MapFinder. 
Besides you can report all mapfiles or view a specific map pictures 

 
When you press the Check Campaigns in folder or the Check Scenarios in folder buttons, the Suite 
looks for missing files for the campaigns or scenarios of the Efile selected, and if any it shows a 
window that allows you to read a complete report. 



 
Open Suite - Manual 

 

 Page 7 of 29 Version 0.1 

 
In the report, you can access the links 
to the missing maps to download them 
manually and copy them to the MAP 
folder. 

 
Next you can see a Check 
Files View with some 
errors in the campaigns: 
the two campaigns with 
<NoP> following their 
name and scenarios 
number are “No Playable” 
as they have some critical 
files missing. In the lower 
center the Suite shows that 
two maps are missing; if 
you clic in Download 
missing maps as png, the 
Suite will try to download 
them. 
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If succesful, it will inform 
you, and the Check Files 
View will update to show 
the changes. 

 

4.2.2. Campaign view 
In this window you can create, edit, view, check… the scenarios that form a campaign, as well as 
the campaign path, prestige settings… To load any scenario from a campaign, just double click on 
its name. We will talk about this view in the Campaign chapter. 
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If you select a choice scenario, this window changes to something like this: 

 

4.2.3. Scenario Summary view 
Here you create, edit, check, view… scenarios; more on this later. 
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4.2.4. Unit Settings view 
In this window you can add, edit or check the units in a scenario. 

 

4.2.5. Map Settings view 
In this window you place the units in the map, work with special hexes (Victory, Supply, 
Escape…), and edit some characteristics of the map. 
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4.2.6. Equipment File Maintenance view 
This window is used to create, check and edit Efiles. 

 

4.2.7. Map Editor view 
This window is used to create and edit the map: terrain, roads, rails, names… 
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5. Efile selection 
To start working with the Suite, first you must change to any Efile folder. This will allow the Suite 
to select the right flags, countries, scenarios and campaigns automatically. 
Let’s suppose that you want to work with the Composite Efile: you press the Change Efile folder 
button or go to Tools  Change Efile folder, and select the “Efile_COMWW2” folder. 

 
After you select the Efile folder, you should see it in the Check Files View and in the window title 
bar. 

 
If the Efile folder that you want to select it’s not in the list, remember that any valid Efile folder 
must have at least a SCENARIO subfolder. 

6. Loading a campaign 
You can load any campaign with the Load CAM button or with File  Load campaign, and then 
double click in the scenario in the Campaing View. 
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When you select any campaign in this 
window, the campaign title and the number 
of scenarios are shown in the bottom, so 
you can choose the right campaign. 

When the campaign loads, the Suite shows the Campaign View. 

 
If you want to select a PG2 campaign, or 
one in the old formats, then you must 
select this in the Type combo-box at the 
bottom of the window. 
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After the campaign loads, a window appears with the scenarios that you must convert to the new 
formats, and when you close it the Suite asks if you want to convert them. 

 

After that, you are shown the Campaign View. 

 
If the Efile for the campaign is old, then you could get a window prompting you to select the 
NATIONS.TXT file; you could select the GUI97.TXT file of the Efile instead. It could ask you to 
select a MISC.TXT file; in this window you can select Cancel. 
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The Suite will ask you if you want to create a NATIONS.TXT from the GUI97.TXT. Hint: accept 
to run the conversion if you don't want to get this warning again; besides you will avoid Open 
General asking you to convert each time it loads any file for this equipment: 

 
When you select any of the scenarios in the list to the left, you can see in the window its title, date, 
prestige cap, options, files and to the right the following scenario, depending on victory type; 254 
means campaign loss, and 255 campaign win. 

 
In this example, the selected scenario is number 01 (the scenario numbers start at 00), the title is 
Chiechanow, the date 5 Sep 1939, the cap is 2000 and the AI starts with 150 prestige points; it’s 
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allowed to upgrade and overstrenth in supply hexes, the scenario file is ciechan.xscn and the intro 
file is ge4i.txt; any result takes you to scenario number 2 and gives you 1000 prestige points. 
If you click the Show Protos button, you can see the prototypes that are available if you take a 
Brilliant Victory. In this scenario you cannot get one, as protypess are disabled in the next scenario, 
but if they were not you could see the list to the right (from another scenario). 

  
The Flow & Text summary button opens a window where you can see the full campaign path, the 
campaign intro, and the map and intro of the selected scenario. 
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7. Loading a scenario/savegame 
To load a single scenario, you must press the Load SCN button or go to File  Load Scenario, 
and select the scenario file. If you want to load a scenario from the old formats of from PG2, then 
you have to select it in the list. 

Loading a .xscn file. Loading a .scn file. 
When the scenario loads, the Suite changes to the Scenario Sumary View. 
To load a savegame, you must press the Load Save button or go to File  Load Saved Game, and 
select the savegame file. 

Loading a .xcsv file. Loading a .csv file 
After loading a saved game, the Suite shows the Unit Settings View. 
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8. Basic scenario settings 
In the Scenario Summary View, you have access to all options of the scenario. In the example 
screens, I loaded the scenario Madrid (madrid.xscn) from Composite WW2. 

 
Here is the scenario name, the map 
picture used and the intro text file. If the 
Visible checkbox is ticked, the scenario 
can be selected to play in the game. 

Here you see the turns per day or days per 
turn and the turns to a BV, V or TV. If the 
turns for a TV pass, you lose the scenario. 
You can also see, if they are used in the 
scenario, the hexes to hold and the units to 
exit. 
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Here you see the date, the latitude and the 
atmospheric and ground conditions. The latitude is 
used to determine the weather changes in the 
scenario. 
The iconset is used to set the type of icons used in 
th scenario (normal, snow, desert or jungle) 
You can also see the prestige earned when a 
normal flagged hex is taken (Base), and you can 
use the buttons at the bottom to see the prestige on 
map and the prestige per turn. 

By pressing the Prestige on Map 
button, a new window opens showing 
the total prestige available on the map 
for each player. 

If you press the Prestige x Turn button, 
a new window shows the prestige 
alloted to each player in any turn. 
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Here you see the Player 1 settings: the main 
and support countries, the side and the air and 
naval transport available. The AI stance is 
used if the player is played by the AI and 
determines its strategy: aggressive makes it 
attack the player’s VH, and defensive makes 
it set a defense for its own. 
You can also see how many units the player 
has, and its prestige cost. 
Below is the non-organic transport available 
by type and the default strength and 
experience of new units bought in the 
scenario. 

The section for Player 2 is nearly the same 
than that for Player 1. The only difference is 
that you can change the player to Player 3 and 
Player 4 by means of the list at the top, to set 
other players. 

Here you can see if prototypes are allowed in the 
scenario, the chance of obtaining a prototype, the 
time frame used to determine the prototype 
gained, and its default strength. 
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Here you can see the optional rules used in the 
scenario, and if Air Missions are enabled or no. 
To change the options you can use the Options 
button. 

If you make any modification to the scenario, the Suite shows it at the end of the title bar until you 
save it. 

 

9. Units 
To view the units of any scenario, it’s better to change to the Map Settings View. 

 
The upper right part of the window lets you select some of the characteristics that you want to see in 
the map, like special hexes, units for player 1-4, rails, roads,… 
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Here you can change the terrain of the hexe, and 
set rails, and roads in it. 

This section shows the selected unit. It also has 
some filters, to select the shown units in the 
map: by country, class, status (deployed, 
reinforcement…), and air/ground units. 

Here you can change the hex name, owner, flag, 
set minefields, victory hex type, supply hexes… 

In this section you can change the base hex 
prestige (40 by default), the modifier, set turn 
prestige and trigger hexes. 
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To see the units, it’s better to double click in any empty hex or unchech the Strategic View 
checkbox; then you can see the map in a bigger scale: 

 
The red-bordered hexes are the initial deployment hexes: they are the hexes available to deploy 
your core units at the start of the first turn of the scenario in a campaign; if the scenario is the first in 
the campaign, the units that are there are the initial core units. 
You can right click in any unit to display a window with info about it. 

 
In the upper half, you can change its transport (Transp button), equipment (Equip. button) and 
look at its stats. 
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In this part of the window, you can see the 
unit’s country and side, its experience and 
bars (with Auto bar checked, the bars are 
set automatically according to its 
experience), base strength, current strength, 
entrenchment level, and some fields useful 
to edit a savegame, like hits suffered, 
suppression… If the unit is a reinforcement, 
the turn in wich it arrives is in the Reinforce 
box, and if the unit is going to left the 
battlefield, the turn is in the Disband box. 

This tab allocates a leader to the unit; if there 
is one, you can select if it’s random or 
custom. 

This tab is useful for saved games, and is 
used to change the status of the unit by 
checking and unchecking any of the 
checkboxes. 

In this tab you could set the role of the unit 
(not available yet), and if the unit is 
anchored (doesn’t leaves its position) or 
must hold its position until a given turn. 

You can work also in the Unit settings view, changing with the View menu or with the button in 
the toolbar. 
If you have any unit selected in the Map Settings View, when you change to the Unit Settings 
View it remains selected. 
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10. Efile 
When you are looking at the units in a scenario, you can change to the Equipment File 
Maintenance View, and automatically the same equipment used by the selected unit is shown, 
along with available equipment for the same country and class. 

The Equipment File View has several sections: 
Here is shown the diferent equipment available 
for the country and class of the selected unit, in 
this example Nationalist Spain and Infantry. 
In the upper side, you can see the icon used and 
its name. 

Here are the unit’s stats. They cannot be changed if you have the 
Avoid editing Efile unless loaded explicity checkbox checked in 
the Settings window of the Suite. If you want to edit the Efile and 
have this checked, you must load the Efile with the Load EQP 
button or from the File menu. 
For an explanation of those stats, you can read the Open General 
Manual. 
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Here are more characteristics of the selected equipment: its 
Country, Front-Faction, Class, Type, Movement, Target type, 
availability dates (From, Until), No-Organic Transport and 
Special attributes. 
To know the meaning of those characteristics, you can also read the 
Open General Manual. 

Those are filters, to show only the equipment 
that matches ALL filters. In this example 
only units from Nationalist Spain AND 
Infantry are shown. 
The units can be sorted in many ways; in this 
example by code number. 

This are the special attributes of the unit: 
it can clear mines and cannot be given as 
a prototype. 
If you want to know the meaning of those 
attributes, you can look in the Open 
General Manual. 

This tab shows the sounds used by the 
unit when it moves, attacks and dies; you 
can also listen to the sounds by clicking 
the Move, Attack or Die buttons. 
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In this tab you can see the transport types 
that can be used by the unit. 

Here are some unit’s abilities useful to 
aircraft when Air Missions are enabled. 

The status bar shows some information about the efile and unit selected. 
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11. Links 
Here you have some links to the main webpages with material for Open General and Panzer 
General 2: 
Luis Guzmán’s web page: 
http://luis-guzman.com/ 
JP’s Wargame & History Forums: 
http://www.panzercentral.com/forum/viewforum.php?f=178 
Kaiser General: 
https://sites.google.com/site/jkpanzer/ 
Steve PG2 Campaign: 
http://hosted.wargamer.com/pg2campaigns/steve/pg2.htm 
Gilestiel PG2 Mapfinder: 
http://pg2mapfinder.gilestiel.eu/ 
Adlerkorps: 
http://www.adlerkorps.com/ 
Latin Generals: 
http://gilestiel.nerim.net/lg/ 
The MG Bunker: 
http://sites.google.com/site/themgbunker/ 
OpenGeneral & PanzerGeneral (polish): 
http://www.pg2.net.pl/ 
Polecam (polish): 
http://opengeneral.pl/polecam.html 
Polish forum: 
http://www.forum.gildiageneralow.pl/opengen/0/ 
Rayydar’s (German): 
http://www.rayy.de/raiders/pages_e/RayyFrames2N.html 
Panzerliga: 
http://www.panzerliga.de/en/index.php 
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13. Version history 
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